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Family Tree Maker, usually called FTM, is Australia’s 
largest selling genealogy program. It has enjoyed 
huge success and is now in its 22nd iteration 
as FTM 2014. In December 2013 Ancestry.com 
announced Family Tree Maker Mac 3 which was 
released in Australia in March 2014.

The program has developed extensively and since 
purchased by Ancestry.com in 2004 it has become 
even more tightly integrated with the  
Ancestry.com database. It has also become very 
internet aware with its use of Bing Maps and 
the ability to link to internet sites like Trove 
from within the program as well using a very 
convenient web clipping and merging capability.

The program is sold throughout Australia and 
New Zealand in retail packs that include access to 
Ancestry.com paid databases.

This book is intended to be the first of a series 
about Family Tree Maker, and covers the absolute 
basics that new users, with very little computer 
understanding can use to get up and running.

The book takes new users through installation, 
registration, activating an Ancestry.com 
subscription, followed by an introduction to 
creating or importing files. It then introduces the 
eight workspaces within the program with enough 
simple explanation to start using it.

Extensive use is made of screen shots to assist the 
user to understand what he or she is seeing on the 
screen. 
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Foreword
If you’re totally new and just learning how to use Family Tree Maker, then 
you have in your hands one of the best tools for getting started. In fact, John 
Donaldson was instrumental in helping me as I was introduced to Family Tree 
Maker ten years ago. That’s when I first became acquainted with John and came 
to rely regularly on his expertise and guidance along with a few other carefully 
selected advisors. In the years that followed, Family Tree Maker has changed a 
great deal and John has been involved every step of the way. His expertise has 
helped countless others, as John has been teaching, writing and helping people 
with Family Tree Maker in Australia and abroad for more than 15 years. 

Family Tree Maker is a powerful but easy-to-use program for helping you to 
discover, preserve, and share your family’s heritage. It is available for Windows 
and Mac computers and John is versed and familiar with both, given his long 
history with using the software. Although it is intended to be accessible and easy 
to learn, getting started with a new software program can be daunting at first. 
There are so many screens with so many options and terms you’ll be unfamiliar 
with. In this book, John uses his experience and friendly style to teach, guide, and 
help you focus on what you need to know first. As you begin this new endeavour, 
you have the ideal companion at your side. Best wishes in this exciting new 
journey.

Duff Wilson
Family Tree Maker
Ancestry.com
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Abbreviations
CD  Compact Disk
CD-R  Compact Disk Recordable
DD/MM/YY Day/Month/Year (Date)
DVD  Digital Versatile Disk
FTM   Family Tree Maker
GB  Gigabyte
MB  Megabyte
MHz  Megahertz
RAM  Random Access Memory
ROM  Read Only Memory
TV   Television
VicGUM  Victorian GUM Inc.
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Getting started 

Introduction
There is no doubt that genealogy and family history have become very popular 
in recent years with the advent of capable computers, smartphones, the internet, 
online databases and also being popularised by TV programs such as, ‘Who Do 
You Think You Are?’

Computer programs that assist you with your genealogy have been available 
for many years, and have developed to offer more and more features as well as 
becoming internet and smartphone aware. They have also become much cheaper 
as well as being much more capable.

This book has been designed to assist users, (often seniors) or those that have 
not grown up with computers, to understand the basics of one of the most popular 
genealogy programs—Family Tree Maker.

Family Tree Maker for Windows
Family Tree Maker (normally abbreviated FTM) is Australia’s biggest selling 
genealogy program. It is available for both Windows and Mac computers. It has 
been around in a Windows version since 1990 and has grown a strong following. 
The program was purchased from Genealogy.com by Ancestry.com in 2003 and 
was totally rewritten and released as Family Tree Maker 2008. Since then it has 
significantly evolved and the current Windows version is Family Tree Maker 
2014 released in September 2013.

Family Tree Maker for Mac
Ancestry.com has also released a version for the Mac operating system in 
2014 called Family Tree Maker for Mac. It is now in its third version Family 
Tree Maker Mac 3. Both programs are available in Australia and are strongly 
supported by one of the major computer genealogy associations, Victorian GUM 
Inc. (VicGUM®) www.vicgum.asn.au.

This book has been written for those users who have recently purchased 
Family Tree Maker and want to know what to do next. It will cover the basics to 
get you going and gain confidence in the program.
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Obtaining the program
Family Tree Maker is widely available in Australia. Whilst it can be obtained 
from some retail chains, it is perhaps better to purchase it from a specialised 
genealogy outlet that can provide active phone and Internet support, especially 
to new users. One such supplier is Victorian GUM Inc, (VicGUM®) a not for 
profit organisation established in 1984, with the view of assisting people use 
their genealogy software more effectively. Family Tree Maker can be purchased 
through Vic GUM® at this link: www.vicgum.asn.au/software.html

Windows versions of Family Tree Maker 
The current version of Family Tree Maker for Windows is Family Tree Maker 
2014 and is available on CD in three versions:

• Platinum Edition, which includes 6 months subscription to Ancestry.com.au 
UK Heritage Plus

• Deluxe Edition, which includes 3 months subscription to Ancestry.com.au 
UK Heritage; and the

• Upgrade Edition, which is only available to users of previous versions of 
Family Tree Maker, and includes 1 month’s subscription to Ancestry.com.au 
UK Heritage.

In all cases the version of Family Tree Maker is identical, the difference is the 
amount of Ancestry.com.au subscription. 

Mac version of Family Tree Maker 
The current version of Family Tree Maker for Mac is Family Tree Maker for 
Mac 3 Platinum. Like the Windows Platinum version, it comes with 6 months 
subscription to Ancestry.com.au UK Heritage Plus.

For details of the contents of Ancestry.com subscriptions see:
www.ancestry.com.au/14daysfree#compare

Various Ancestry subscription packages
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Different operating systems, different files
With Family Tree Maker 2011 and 2012 and Family Tree Maker Mac 2 the files 
for the Windows and Mac programs are incompatible. 

The solution is to install the File Migration Utility that ships on the FTM for 
Mac CD, but has to be installed onto a Windows computer! That is correct. Even 
although the Utility comes on the Mac CD, it has to be installed under Windows. 

The Utility will convert Family Tree Maker Windows .FTM files to Mac 
.FTMM files and vice versa. The Utility can also be downloaded from  
http://ftm.custhelp.com/app/answers/detail/a_id/5313/kw/file%20migrat%20
ion%20utility

You can still use GEDCOM to transfer files between the programs.

What is a GEDCOM?
GEDCOM is the data transfer standard used by various genealogy programs. 
For example, if your cousin used Legacy Family Tree, which is a competitive 
program to Family Tree Maker, you could make a copy of your file (or part of it) 
as a GEDCOM file and he/she can open it with Legacy. Family Tree Maker can 
export your file as a GEDCOM via File>Export>GEDCOM.

New development with 2014 and FTMM3—a common database
Thankfully with the release of Family Tree Maker 2014 and Family Tree Maker 
Mac 3, the developers have made the database structure between the two 
versions compatible. That means that Family Tree Maker 2014 can open a file 
created in FTMM3 and vice versa. No more File Migration Utility! This is a big 
breakthrough.

Export to GEDCOM
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64 and 32-bit options
Also note that Family Tree Maker 2014 ships in two varieties on the installation 
CD, namely 32-bit and 64-bit. If you have your version of Windows installed 
as 64-bit, Family Tree Maker 2014 will automatically detect this and install the 
64-bit version of Family Tree Maker. 64-bit makes better use of your computer’s 
resources and will run up to 50% faster on a given file and computer than the 32-
bit version, which is the same speed as Family Tree Maker 2012. Note you don’t 
have to do anything the program will detect the correct version.

Lots of references in Google and this one is quite good.
www.techsupportalert.com/content/32-bit-and-64-bit-explained.htm

Can I install FTM on my computer?
In order to install Family Tree Maker on your computer and to ensure that it 
runs satisfactorily, it is necessary for your computer to meet the minimum or 
recommended specifications. Note in the specifications that follow, the developers 
have recommended minimum specifications and recommended specifications.

I publish both, but note that Family Tree Maker is essentially a large database 
management application and the more memory (RAM) that you have in your 
computer, the better (faster) it will run. I have noted my recommendations, 
especially for large files (more than 1000 people) and 64-bit operation as well.

What I use
I use a 27” iMac (Mountain Lion OS-X 10.8.5) with Windows 7 Pro installed 
as well running under Parallels 7. This lets me run both Family Tree Maker 
Windows and Mac programs on the one computer—essential if I wish to write 
about both versions of Family Tree Maker. I have 8GB of RAM for the Windows 
side and another 8GB of RAM for the Mac side. Both Windows and Mac run in 
64-bit mode. 

I also have an older Windows XP Pentium test computer that has Family Tree 
Maker versions 16, 2009, 2010, 2011, 2012 and 2014 on it. Good for answering 
questions.
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Family Tree Maker for Windows
Minimum requirements

Operating System Microsoft Windows® XP SP2 / Vista™ / 7/ 8
Processor 500 MHz Intel Pentium® II (or equivalent)
Hard Disk 639 MB for installation
Memory 512 MB of RAM
CD-ROM Drive 2 x CD/CD-R. (Some supplemental products require a DVD-ROM 

drive)

Monitor 800 x 600 resolution monitor

Recommended requirements

Operating System Microsoft Windows® XP SP2 / Vista™ / 7/ 8
Processor 1 GHz Intel Pentium® III (or equivalent)
Hard Disk 639 MB for installation
Memory 1 GB of RAM
CD-ROM Drive 32 x CD/CD-R (Some supplemental products require a DVD-ROM 

drive)

Monitor 1024 x 768 resolution monitor

Family Tree Maker for Mac
Minimum requirements

Operating System Mac OS-X 10.5 or later
Processor Intel-based Mac
Hard Disk Space 500 MB for installation
Memory 512MB of RAM
CD-ROM Drive 2 x CD-ROM (required for installation)
Display 800 x 600 resolution monitor

Recommended requirements

Operating System Mac OS-X 10.5 or later
Processor Intel-based Mac
Hard Disk Space 500 MB for installation
Memory 1GB RAM
CD-ROM Drive 32 x CD/CD-R (Some supplemental products require a DVD-ROM 

drive)
Display 1024 x 768 resolution monitor
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My comments
My experience with both Family Tree Maker for Windows and Family Tree 
Maker for Mac is that even the recommended RAM of 1GB is really too low if 
you want to run a file over 1000 people. I would suggest that you have at least 
4GB of RAM for 32-bit operation (that is the most that 32-bit Windows can use) 
and 8 GB of RAM for 64-bit operation. Other programs will run a lot better as 
well with more RAM. Intel Processors i3 or above, e.g. i5, or better still i7 (or 
equivalent), will also perform much better than the older Pentiums etc.

Installing the program
Installing the program is extremely straightforward and consists of inserting the 
program CD into your CD drive and following the prompts or as they say in the 
song, ‘Follow the yellow brick road’.

One Tip: When installing any CD, have a look at surface and make 
sure that it is clean. Dirty CDs in any program can cause problems with 
the installation.

If your computer does not have a hard drive, e.g. a Mac Air, you can, on 
another computer, copy the files on the installation CD to a memory stick and 
then install from the memory stick.

Sometimes when you are installing the CD, you will see a message from 
Avanquest, who package the CDs for Australia and New Zealand. If you don’t 
have any interest in receiving information from Avanquest, simply hit the escape 
key (esc) and proceed with the installation.

Family Tree Maker will not overwrite any previous version and will install as 
a separate program in its own right. In fact on my test computer, I have versions 
16, 2009, 2010, 2011, 2012 as well as 2014 installed. I do this as I answer a lot 
of questions so I need the older versions there as a reference if required. Most 
people though, if upgrading from a previous version, once they have the latest 
version working correctly, uninstall (Windows) or delete (Mac) the older program 
so as to free hard drive space.

Registering the program
This is an important step as it activates a number of features. The program will 
ask you for a username and password. If you have registered a previous version 
of the program and/or have an Ancestry.com.au subscription you should use this 
username and password.
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How does Family Tree Maker relate to Ancestry.com?
Ancestry.com owns and develops Family Tree Maker and the Family Tree Maker 
program is very tightly integrated into Ancestry.com. By using the same Ancestry.
com username and password ensures that you have access to all the Ancestry.
com products/benefits whether you are utilising them through Family Tree Maker, 
from a browser, tablet, or smart phone, etc.

Ancestry.com.au subscription
I mentioned above that the product comes with a subscription of various lengths 
to the Ancestry.com paid databases. Once you have Family Tree Maker installed, 
you can activate this subscription via Help>Activate Ancestry subscription 
(Windows), or in Mac click on the Family Tree Maker button on the tool bar 
(next to the File button). Note that when you activate your Ancestry.com.au 
subscription that comes with Family Tree Maker, you will still be asked for valid 
credit card details. If at the end of the included period you do not wish to continue 
with your subscription, you need to cancel the subscription before it expires. You 
can do this online.

First program registration screen

Activate Ancestry subscription
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If you don’t cancel your subscription will be continued, and of course you will 
be charged. Your subscription status and expiry is shown on the web dashboard in 
the Plan view (both versions).

When should I take up my subscription offer?
If you are a new user to Family Tree Maker, I recommend that you delay taking 
up your subscription until you are a bit more comfortable with the program as the 
subscription is time based, e.g. the clock starts ticking the moment that you activate it. 

As far as I am aware, you can delay activation for as long as you like. You can 
also use it to extend an existing Ancestry.com subscription. I suggest that you do 
this when your current subscription expires.

If you have any problems with this you can ring Ancestry.com.
1-800-251-838 (toll free) in Australia or;
0800-442-100 (toll free) in New Zealand.

How many copies of family tree maker can I install?
A question often asked, and the rule is that you may install two copies of the 
program on any two computers that you own. You may have one on your desktop 
and the second copy on a laptop. Any combination, but the number is two copies.

Getting started
So we have covered the preliminaries and have installed and registered Family Tree 
Maker and possibly activated an Ancestry.com subscription. What happens next?

The eight workspaces
Family Tree Maker now has eight workspaces where you do the work. These are: 
Files, Plan, People, Places, Media, Sources, Publish and Web Search. Regard 
them as your eight pillars of family history wisdom as you will spend a lot of time 
in all of them.

They all operate a bit like eight open tabs in a browser, and in fact one of 
the things that I really like with Family Tree Maker is that you can move to any 
workspace at anytime, but when you come back to a workspace, it is exactly how 
you left it. So you could be working with a family in the People workspace and 
jump to Places, then Media and then come back to the People workspace. Note 
Family Tree Maker 2012 and FTMM 2 only have seven workspaces, the file 
selection option is part of the Plan view.

The eight workspaces (Mac)

The eight workspaces (Win)
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Chapter 2—Files workspace
This is a new workspace in Family Tree Maker 2014 and FTMM3. It shows you a 
(shortcut) list of the last opened files. 

The reason the new workspace was created was to allow you to change files 
from anywhere in the program. Previously you had to go to the Plan workspace to 
change files. If the file you want is not listed in the Files workspace, you can click 
the browse button and locate it or go to File>Open and navigate to where you 
have saved your Family Tree Maker files, usually My Documents>Family Tree 
Maker. Once a file has been opened once, it is usually then available in the Files 
workspace and clicking on it will open the file. You can also rename, delete or 
remove a tree from the trees list.

Files menu
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Chapter 3—Plan workspace

Family Tree Maker 2014/FTMM3
In Family Tree Maker 2014 and FTMM3 the Plan workspace has been updated. 
The developers will tell you that they have updated the UI (User Interface). 
Nothing new has been added, just rearranged from previous versions.

Here you can see details and statistics of the current file opened, you can see 
if the file is linked and synced to your online tree. You have a large area to record 
global tasks and you also see the Ancestry web dashboard and Ancestry connect 
activity.

Family Tree Maker 2012/FTMM2
In Family Tree Maker 2012 or FTMM2, when you start Family Tree Maker it will 
open in the Plan workspace. This workspace is where you see details of any files 
that you have. 

You also have the ability to create a new file, or import a file from one that 
you already have, e.g. from an earlier version of Family Tree Maker right back 
to version 5, maybe a GEDCOM file, maybe your online Ancestry Member Tree, 
or maybe from another genealogy program like Legacy Family Tree, The Master 
Genealogist or Personal Ancestral File (PAF). Family Tree Maker can import 
them all. Also, you can create a totally new tree from scratch, e.g. enter just what 
you know. You can also list global tasks (To Do items) in this workspace.

The Plan workspace  (Win)
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Linking to an online Ancestry Member Tree (AMT)
Versions 2012/2014 and FTMM 2/3 both allow you to create an online Ancestry 
Member Tree (AMT) and link and sync your Family Tree Maker data to the 
online tree and vice versa. Many people (including me) have done this as a 
convenient way to share data, but you don’t ever have to do this if you don’t want 
to.

It is an option that you can avail yourself of at anytime. The advantage of 
an online tree is that you can selectively share your research. I regard it as an 
extension of the Publish capability, an ‘online chart/report’ if you will. Both 
versions allow you to link and sync your tree from Family Tree Maker online so if 
you make a change to (say) your Family Tree Maker tree it will be synchronised 
to your online tree and vice versa. 

Using your online tree on smart phones and tablets
Additionally, you can look and edit your online tree from any browser or better 
still from a tablet, smart phone or iDevice. To do this you need of course to install 
an Ancestry.com app. This lets you look and edit your online tree from anywhere 
in the world that you have a phone or Wi-Fi connection and if it is linked and 
synced the changes will be transferred back to your Family Tree Maker tree next 
time you open it. Both apps are free and are great for travelling.

The links are:

Apple
https://itunes.apple.com/us/app/ancestry-com-tree-to-go/id349554263?mt=8

Android
https://play.google.com/store/apps/details?id=com.ancestry.android.apps.
ancestry

Free cloud backup
With 2014 and Mac 3 the online tree now has all your data (though not all will be 
visible) so it is a great way to backup your tree (free) online. Note the capability 
to create an online AMT is not related in any way to the paid subscription service 
Ancestry.com has to give you access to their numerous databases and merge them 
into Family Tree Maker.

The online AMT capability is free and will always remain free. It is part of 
your ownership of Family Tree Maker. 
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Starting a new file
There are three ways to start a new file.

A new tree—enter what you know
Let us say that you have never put any of your information into a computer 
genealogy program like Family Tree Maker and you have boxes full of paper with 
notes, diagrams photos and other memorabilia. From the Plan workspace, click 
on the ‘New tree’ tab. You can also import from other sources here but let us just 
focus on a total new start.

First add a name. But what name? I suggest that you start with yourself. 
Reason…. you are likely to know more about yourself than anyone else. So add a 
few details (even just your name will do) and press Continue. Family Tree Maker 
will create the file and open you in the People workspace Family view.

Import from an existing file
The second way is to import a file from an earlier version of the program, or 
from a GEDCOM, from Legacy Family Tree or from The Master Genealogist. 
Obviously this is the quickest way to get started.

Linking with an online tree

Enter what you know
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Import from your Ancestry Member tree
If you already have an online Ancestry Member tree, you can import this into 
Family Tree Maker. 

So three ways to get started. Use the one that suits your needs. Once you have 
your file into Family Tree Maker it will open it when you start the program, or 
you can open it from the Files workspace.

Congratulations, you have just created your first file. Now you can start to 
add other data like date of birth, place of birth, parent’s details, spouse, siblings, 
children etc. You will in fact spend most of your time in the People workspace 
and a warning, this is where you will likely catch the genealogy disease. 
Fortunately it is non-fatal, but there is no known cure.

The symptoms include finding yet another name, or date, or photo or story. 
Assuming your ancestors and their records survived Noah’s flood, when you get 
back to the lady who ate the fruit, you may consider that you have finished your 
family tree.

Import from an existing file

Import from an existing Ancestry online tree
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Now a word about terminology, files, saving and backing up
When I talk of a file I am talking about a computer file created by Family Tree 
Maker. This is like any other file that you create in another application like (say) 
a Word file in Microsoft Word. Other terms are also used like, ‘Family file’, ‘Data 
file’, etc. This is the file that has all your hard work. In my case, years of work, so 
it pays to back it up on a regular basis.

But where is the Save button?
By now you may have noticed that Family Tree Maker does not have a save 
button anywhere. 

What is going on?
Well every time you add or remove any data, Family Tree Maker saves it 

behind the scenes. When you close Family Tree Maker, a copy of the file is 
also backed up to your operating drive (C:) drive. It has the form ‘Myfile.FTM’ 
(Windows) and ‘Myfile.FTMM’ (Mac).

File Backup command
Hard drives can fail, so have a copy on another hard drive or CD. I cannot 
emphasise enough the importance of using the File>Backup command in Family 
Tree Maker. This command backs up your file, media and links to your online tree 
(and historical events in 2012/14 Mac 3). 

The backup is a zipped file (compressed) with the extension ‘.FTMB’ 
(Windows) and ‘.FTMMB’ (Mac). 

I strongly suggest that you make regular backups to external media e.g. CD, 
offline hard drives, memory sticks, the Cloud, e.g. Google Drive, etc. Note in this 
example I have selected Google Drive.

Backup file dialogue 
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Your online tree is a good free cloud backup
With 2014 and Mac 3, the new enhancements to the link and sync and online 
Ancestry Member Trees mean that these online trees now offer a free cloud 
backup for your precious data. 

It is good insurance and good risk management of your computer data. It 
applies to other vital data as well, e.g. documents, photos, etc. Also, don’t keep 
all your copies of your backup files in one place. Australia has had its share of 
bushfires, floods, etc. Enough warnings.

A playfile
At the various workshops that I participate in, I always advocate having a playfile 
or sandbox file. This is a copy of an old file, or part of it, or maybe just a short 
file with some names and media, etc., in it. You can use this file to experiment 
with new ideas or procedures that you may not be comfortable in. Once you have 
mastered them you can then apply your skill to your main file. Regard a playfile 
like a golfer who has a few practice swings before hitting his/her shot. It does 
not matter if you wreck your playfile; simply make another one. I have one with 
a few Flintstones TV characters in it and was amused when showing it to my 
Family Tree Maker user group that I got an Ancestry leaf hint for Fred Flintstone!

Options
At this stage you may also want to have a look at the options in FTM to define 
how you will enter dates DD/MM/YY or MM/DD/YY, how the screen looks, 
your internet connection etc. Having a look at the options is useful in any new 
program. In Family Tree Maker for Windows go to Tools>Options and make your 
adjustments. In Family Tree Maker for Mac 2/3, go to the Family Tree Maker for 
Mac button on the toolbar and select Preferences.

Family Tree Maker 2012/14 options (Win)FTM Mac 2/3 preferences
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Chapter 4—People workspace
Welcome to where you will spend most of your time. In this view you see an 
index, a pedigree view, parents’ and children’s view and in the right hand panel an 
editing area. 

Also note that you can configure the various panels by dragging on the little 
dots on the edges of the views so that you can focus on a particular area. This is 
really useful if you are working with a small screen laptop.

Adding new information
As you grow your family tree, you will add more information such as names, 
dates, places, notes etc. You add information in the People workspace. To add a 
child simply click on the Add Child field at the bottom of the existing children’s 
list. The name will appear in the right hand editing panel where you can add 
further details. You can add even more details by clicking on the person tab and 
look at the Facts area—see illustration below.

If you want to add new parents, click on the Add Parents in the centre view. 
Again, as with children, as you add a new name the new name appears in the right 
hand editing panel. Note when entering female names, you should enter them 
with their maiden name.

The Index
As you add a name, it is added to the Index that is shown in the left hand panel 
when in the People>Tree View. Note the Index also appears in many parts of the 
program where you need to use it with an icon looking like this.

Note with the Index you can have it displayed in many ways including 
showing lifespan—my favourite but sorted by birth date, marriage date or death 
date as well as displaying names as Family Given or Given Family and AKA 
(Also Known As), titles and married name for females. The Index also allows you 
to Bookmark a name (right click on the name and add Bookmark). 
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Bookmarks
Bookmarking names allows you to use the Bookmark list below the Index so you 
can focus on particular names. It is sometimes useful to Bookmark the oldest 
person in each line for quick reference.

History
The History tab allows you to see a list of recent edits and hovering your mouse 
over a name will provide detail history information. Note the person also 
bookmarked with the book icon next to their name.

Index (part)

Bookmarks

History
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The views in the Family workspace
Family Tree Maker 2014 and Family Tree Maker Mac 3 have added a new family 
view, which is similar to the view that you see in the online Ancestry Member 
Tree. The old Pedigree view is there as well and a small vertical toolbar allows 
you to toggle between the views.

The Home person
This is a particularly useful feature for as you add people, their relationship to 
the home person appears in the top right hand silhouette box. This is not only 
interesting as you add names, but also assists in validating that you are not doing 
something wrong. I usually make myself the home person. To designate a home 
person, right click on the person in the index and then set as a home person. You 
can change this to someone else at anytime. The home person is shown in the index 
with a small ‘Monopoly’ house icon next to the name. No matter where you are in 
Family Tree Maker, clicking on the home person icon will always take you home. 

FTM 2012/14 People Family view

FTM 2012/14 People Family view Family Tree Maker 2014 Pedigree view
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Follow the Yellow Brick Road
You may have noticed in the children’s area are arrows pointing to the next lowest 
generation. If you see a yellow arrow this is the route back to the home person. 
Another neat way to navigate.

Turning on the Description field
At this point I want to introduce the Description field that goes hand-in-hand with 
the Date and Place. You may have an entry (say) Born 30 May 1890 in London, 
England and you want to add a description (say) a hospital name.

How do you see the Description field in the People workspace? This is how you 
do it. 

For any person in your file, go to his/her Person view and select the birth fact. 
Now in the Options button in the right hand editing panel, select Fact Properties 
and check the Date/Place/Description radio button. This will turn on the 
Description field for all the birth events in the file. Repeat the process for other 
fields that you want a Description field. I normally have a visible Description field 
for birth, christening, marriage, death and burial events. Note that you only have 
to do this once for any event in your database, so do birth once and it applies to 
all births in that particular file. Highly recommended.

Leaf hints
When you are entering names in the Family view you may notice little leaves 
(called leaf hints) appear in the boxes in the pedigree and family views and also 
in the silhouette view in the top right-hand corner of your screen. What do these 
mean? What is going on is that Family Tree Maker is constantly checking the 
Ancestry.com paid databases to see if there is a likely match to what you are 

Turn on Description field
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entering, and what other data may already exist. It indicates a possible match by 
displaying the leaf hint. If you mouse over the leaf hint you will see what Family 
Tree Maker has discovered. Clicking on the leaf hint takes you to the Web Search 
workspace where, if you have a subscription to Ancestry.com, you can view and 
merge the data. I will cover that when I get to the Web Search workspace.

Sorting children
When you look at the children’s area you will see that there are some buttons 
for moving children up and down the list according to their ages. Also next to 
the up and down buttons is a sort children button, which sorts them all at one 
click. These are useful but only apply to any one family. If you have a number 
of children out of birth orders scattered around various families then things get 
a bit more tedious. Whilst you can using the data errors report find them and fix 
them one by one, in Family Tree Maker 2014 and FTMM3 the developers have 
provided the user with a new global children sort capability. And it is a real boon.

Automatic/manual (global) child sorting
A big hurray!!

A family’s children can be sorted manually or automatically. All existing 
families are initially sorted manually as they were before they were imported into 
Family Tree Maker 2014, and will remain so unless the user changes them to be 
sorted automatically. New families are sorted by birth automatically by default. 
Once any family is sorted manually, it will stay manually sorted unless the user 
changes it to be sorted automatically. 

Automatic sorting options are available from the Family panel child sort button 
or by choosing ‘Sort All Children By Birth’ from the ‘Tools’ menu. 

Indicated leaf hints

Global sort children
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Unknown dates
Of course you can have a situation where you don’t know the children’s birth 
date. Family Tree Maker provides a number of date options.

These are, About <date>, Before<date>, Circa<date>, Between <date-date>, 
After <date>. So you could enter a date ‘Before 1863’, or ‘After 30 June 1766’, 
etc. When you have a person with two spouses and you don’t know the marriage 
dates, consider adding some dummy dates so spouse one appears before spouse 
two. I have found a good dummy date for spouses marriage in the eighteenth 
century is about 21 years after their birth. Later research may disclose the correct 
information and then of course you change it.

Blended families
This is a great new feature that had been added to both Family Tree Maker 2012 
and Family Tree Maker for Mac 2 and of course continues into 2014 and FTMM3. 
Sometimes you have a situation of multiple spouses with issue from both spouses.

Turning on Blended families lets you see all the children in one view. You can 
also engage it in the Family Group Sheet. The Blended families control is next to 
the children’s sort button.

Children Move, Sort and Blend controls
Note as Sort Children and Blended families work on the same set of data, i.e. 
a list of children, it follows that they cannot both be active at the same time. If 
you have blended families turned on, the sort will be greyed out and inactive. So 
best to do your sorting first, even quicker with the new global sort, then turn on 
blended families if required.

People Person view
This tab takes you to three additional views that allow you to enter a whole lot 
more information about a person or family. Here is where you enter Facts, Notes, 
Media, Web links, Individual Tasks (for the person), as well as being able to see 
their timeline and set family relationships. 

People workspace 
Person view
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Tabs
In this person view you have three main tabs, Facts, Timeline and Relationships 
(arrowed). Notice also at the bottom of the screen is an area for Notes, which can 
also be made private or even research, only you can see them. Private notes don’t 
show up in reports, book, charts or stories. You also have tabs for Media, Web 
Links and Tasks. The Web Links feature is not in Family Tree Maker for Mac 2 
but is in Mac 3. So, to enter data into the various fields such as birth, date, place, 
description etc, you simply type in the information. Note also the mini-pedigree 
chart at the top of the page, which allows you to easily navigate around. It also 
includes an index button. The screen shot (People workspace Person view) does 
not do justice to the screen as it is almost the full screen. I encourage you to study 
it in detail as it has a lot of important capability.

Facts
It is here where you add the Facts for a person, or shared facts like a marriage. 
Adding facts involve clicking on the Blue + icon where you will get a list of 
Facts that you can add. Duplicate facts are also supported. For example, you may 
have two dates of birth for a person. You can enter both and make one preferred. 
This is the one that will appear in charts and reports. Later research may clarify 
the correct date and then you would delete the now unwanted duplicated fact by 
pressing the Red x button and confirming delete or, my method, right clicking 
on the unwanted fact and then deleting it. You can also create your own facts by 
pressing ‘new’ on the fact select list.

People workspace Person view 
Facts
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Timeline
Clicking on the Timeline tab reveals the timeline of a person. Again you can 
enrich this by right clicking and adding family events and also historical events. 
In Family Tree Maker 2012 and Family Tree Maker 2014, (but not Family 
Tree Maker for FTMM3), you can also add your own historical events by the 
Edit>Manage Historical Events menu button. One could imagine the Kerrigan 
family of the ‘The Castle’ fame adding a family historical event of winning in the 
High Court of Australia. Historical Events is not in FTMM3.

Relationships
This is quite an important and often neglected tab. It is in this tab that you can set 
relationships like married, partners, etc. 

Set marriage ending status. Family Tree Maker uses ‘ongoing’ as a default and 
it seems silly to me to have a situation where one or both partners has died say in 
1898 and the marriage status in the Marriage Report says the marriage is ongoing.
You fix it in the Person>Relationship tab. 

Also in this area is where you can indicate adoption and in an adoption 
situation you can have two sets of parents, the natural ones and the adopted ones. 
You can set which appears on the reports and charts.

People workspace 
People view timeline
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So three very important Tabs in the Person view.

Help
Now at about this stage you might be looking for some help. Where is it? Well 
Family Tree Maker has an abundance of help. First of all there is context sensitive 
in program help. In any part of Family Tree Maker simply click on the F1 key. 
This (mostly) will open a help screen related to what you are trying to do.

It also includes a help index and a search. Further, in the Help menu you have 
a built in Companion Guide, a 300+ page book written by Tana Pedersen. This is 
on the program CD that you purchased. It is in PDF form and is in the Help Menu 
and will open in Acrobat Reader, or any other program that will open PDF files.

 If you are really new to Family Tree Maker, this may be one to read.
Further, in Family Tree Maker 2012/14 (Windows), again in the Help 

menu, are some excellent training tutorials. These are animated pages with a 
commentary. Unfortunately they are not in Family Tree Maker for Mac but they 
are available online at www.familytreemaker.com/Learn/Tutorials.

The right mouse button
This is the ultimate ‘Get out of Jail Free’ option in Family Tree 
Maker. No matter where you are in Family Tree Maker, by right 
clicking, you mostly get a menu of what you can do in any 
particular view. I encourage you to use this option constantly as 
it duplicates the menu items and is a great productivity tool.

People workspace Person view Relationships
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Chapter 5—Places workspace
As you enter places in the People workspace, i.e. where people were born, 
married, died, etc., you are building up a list of places. So how do you make 
sense of them? Well click on the Places workspace. No pun intended, but this is a 
marvellous place to be in Family Tree Maker. On the left hand side of the screen 
(in the List by Place view) is the index of places that you have entered.

Provided that you are connected to the internet, you will see a Bing map of the 
place selected. The map may be zoomed and in many cases there are ‘bird’s eye’ 
views of cities as well as 2D and 3D views. I encourage you to explore as you 
would in any new place.

And finally in the right hand panel, a list of persons associated with a particular 
place.

Now if you switch the places list to List by Person, you can see migratory 
information and other interesting detail of your ancestor’s travels. You can plot 
travel across the world if that is what your ancestors did.

Places workspace—Place
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Resolving place names
Now one of the very useful things in Family Tree Maker is the Place Name 
Authority or PNA. This is a built in places database with over three million place 
names. Now if you right click on a place name in the places list, you get an option 
to resolve the place name. What Family Tree Maker does is to compare what you 
have entered to what it has in its PNA and offers to replace your entry with the 
resolved entry. You may have entered ‘Melb, Aust’ which Family Tree Maker will 
suggest resolving to Melbourne, Victoria, Australia. 

Resolving places does a number of useful things. It makes your places 
consistent and eliminates various names for the same place. It assists in locating 
the place more accurately on the map. If you have descriptions mixed up with 
places, which often occurs if you have imported your file from another program 
or an earlier version of Family Tree Maker (especially Family Tree Maker 16 or 
earlier) it can separate places and descriptions. 

Places workspace—Person migration

Resolve all place names
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Finally, and this is the most compelling reason to resolve place names, is that 
the consistency allows you to use the built-in custom report to find (say) all the 
people born in Melbourne before 1860 who are buried in the Melbourne General 
Cemetery. I should point out that the Resolve all Place Names screen shot is not 
from my file. It shows how messy places can be entered and also how Family 
Tree Maker can help clean them up.

Hierarchical place names
In October 2012, Ancestry.com released a service release for Family Tree Maker 
2012, though not for Family Tree Maker for Mac. It was later added as a service 
release to Mac 2. This service release is detected and installed by Family Tree Maker 
2012 and Mac 2 and one of the new features it offered was the ability to expand a 
places view so you can drill down in terms of Country, State/Province/County/
Town/Village/Village feature; such as an address, hospital, library, cemetery, etc.  
This of course is also in Family Tree Maker 2014 and Family Tree Maker Mac 3. 

You can then list people associated with a pinpointed location. It took me a 
good weekend to get all my places in the hierarchised format but once done it is a 
joy to have them so organised.

Resolve a single place name

Hierarchical place names format
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Chapter 6—Media workspace
This is where your media are managed. Media usually consists of photos, scans of 
photos or documents, sound clips, video files and the like. In Family Tree Maker 
when you ‘add’ media to a person or a source, etc., you are actually linking the 
media items on your hard drive to the person. 

Family Tree Maker lets you create the link directly or what I think is better, 
it creates a media centre, copies the media item to the media centre and links it 
from there. Whilst this does use up more hard disk space, it does group the media 
in one folder associated with the data file, which makes for easier location and 
backup. Family Tree Maker as well as creating the link to the media item also 
makes a thumbnail image that it uses if it loses the media link at any time. 

Family Tree Maker 2012/14 has a feature to find and restore missing media 
links, but again (alas) this feature did not make it to Family Tree Maker for Mac 2 
but thankfully is in Mac 3. 

To add media
There are several ways to do this. Probably the easiest for a new user is to go to 
the person view in the People workspace>Person tab and click on the Media tab. 
Then click on the ‘New’ button. Family Tree Maker gives you the choice to Add 

Media workspace
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New Media, that is a media item that has never 
been linked to the file, or Link to Existing 
Media where you have already used the media 
elsewhere.

The media item will appear in the space at the 
bottom of the screen. You can repeat the process 
as often as you like. As you are only linking 
media, you are not unduly bloating your files as the links and thumbnails are tiny. 
Once added, media is then available to include in reports and charts.

Changing the silhouette
One common question is how to convert the 
silhouette in the top right hand corner of the 
editing panel in the family view to a picture. 
Simple. Right click on the silhouette and you 
will get an option to either Add New Picture, or 
Link to Existing Picture. An existing picture is 
one already added to Family Tree Maker and a 
new picture is one on your hard drive.

Media categories
One of the very important things to do when you are adding media is to assign 
a category. Categories are very useful as it is the main way that Family Tree 
Maker sorts media. There are a number of provided categories like ‘Family’, 
‘Document’, ‘Cemetery’, or you can create your own custom categories. You 
can also go back to your media items at any time and right click on them and 
categorise or recategorise them. Every time you enter media you will be prompted 
to add a category. You can have multiple categories for any media item.

New in Family Tree Maker 2014
New features in Family Tree Maker 2014 are 
a magnifier to look at more detail and a new 
viewer that lets you look at multi-page PDF files 
inside Family Tree Maker. Unfortunately they 
are not yet in Mac 3. 

Add new media

Magnifier tool

Changing the silhouette



36

Chapter 7—Sources workspace
The subject of sources could take several books on its own and in fact Family 
Tree Maker follows the work presented in the books by Elizabeth Shown 
Mills, Evidence! Citation & analysis for the family historian and Evidence 
explained: citing history sources from artifacts to cyberspace, an 885 page 
tome on sourcing! Family Tree Maker includes 170 source templates according 
to the Shown Mills method. (for a list see www.vicgum.asn.au/downloads/
FTMSourceTemplates2012.pdf)

But I am going to make it simple.

The two elements of sourcing
When you break it down to the simplest terms the whole reason for sourcing data 
is to provide an audit trail for you or other researchers, so as you can establish 
where you obtained the data. Sourcing can distinguish between a fairy story 
family history and solid research.

The first element used to be called the master source now more commonly 
the source. The second element is the citation. Let me give you an example. My 
source is the ‘State of Victoria, Birth Certificate’ and my citation is the particular 
number and data associated with a particular birth certificate. These two pieces of 
information are sufficient to allow the information to be validated. 

Another example—the source may be a book title and the citation a particular 
page. Again, a researcher could verify the source.

Sources workspace
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Adding sources in Family Tree Maker 
In the People view go to say a birth entry. If you mouse just to the right of the 
birth field, a little icon with a + sign appears. Click on this. This then gives 
you a dialog to add a new source citation or link to an existing source citation. 
As we are working with a new file, let’s add a new source citation. In the add 
Source citation type in the name of your source (say) the State of Victoria, Birth 
Certificate. Family Tree Maker will query if it is new. Say yes. Now you can 
add the citation detail as well as notes, attaching media and, new in Family Tree 
Maker 2012/14/Mac 3 a web link. When finished click OK. This source is now 
linked to this person.

There is also a good tutorial in the Help>Training Tutorials in both  Family 
Tree Maker 2012 and Family Tree Maker 2014. Unfortunately the animated 
Training tutorials are not in the Mac versions, but you can look at the Windows 
versions (which are still close enough to the Mac versions) at this online link: 
www.familytreemaker.com/Learn/Tutorials.

Add a new source
You can source every Fact in Family Tree Maker with as many sources as you like. 
Once you have added a source it can be used in reports and charts and Family Tree 
Maker has a number of source reports to help you manage your sources. 

You also have the capability in Edit>Manage Sources to add detail about 
repositories, addresses and other appropriate details. In Family Tree Maker 
2012 and 2014, (unfortunately not in the Mac 2, but now in the Mac 3 version), 
is a report that can show you every fact in your file that does not have a source 
attached to it. It is called an Undocumented Facts Report. It is salutatory to run 
this report on a large file and see how much work you still have to do.

Fig 42 Add a new source
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Chapter 8—Publish workspace
Up until now all the workspaces have been concerned with data input, names, 
dates, places, media, facts and sources etc. The Publish workspace though is 
all about data output. Now the whole point about collecting family history 
information is to produce output, which may include charts, reports, books, video 
and online Ancestry Member Trees.

Opening the Publish workspace
The workspace has two component areas. The first area is the Collection area 
that contains all the various charts, reports and books as well as an area for saved 
reports charts and books. The second area is the Detail area where you can edit 
and modify what are effectively templates in the collection area. Along the top of 
the view is what is called a ‘mini-pedigree’ chart that allows you to alter the focus 
person very easily as well as having access to the index without having to go back 
to the People>Family view.

When you select a chart, a report or book in the collection area, double 
clicking on it, or selecting it and then clicking on create chart will open it in the 
detail area and also open the right hand editing panel. As this book is a primer for 
new users, let me provide a couple of examples.

The Pedigree chart
From the People workspace or the mini-pedigree view, select the person to be 
the subject of the pedigree view. In the Collection view of the Publish workspace 
double click on the Pedigree Chart. This will open a pedigree chart for the person 
selected.

Now in the right hand editing panel (and remember you can make this larger or 
smaller by dragging the edge) you have a number of pedigree chart options. These 
include, Items to Include, which can be some of all your facts about the person, 
then the font which lets you change the fonts used in the chart, then follows the 
most interesting box and line styles where you can alter the size, colour, fill, 
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shadow, etc. of your boxes. You can spend ‘hours’ getting it ‘just right’ here. Then 
there is the ability to insert an image (Media item), a page set up and some saving 
options so you can reuse the report. If you have set up the chart as you want it, 
then you can reuse the settings for another person.

Then if all of that is not enough, you can alter the layout to book or poster, 
nominate the overlaps of the boxes, adjust the spacing, align the nodes, set the 
number of generations, nominate how many per page and add a background 
image or effect (Family Tree Maker provides a range of background 
enhancements and embellishments or you can use your own).
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You can add background pictures, set the transparency and finally include empty 
branches, show generation labels and include duplicate ancestor lines. Finally you 
can locate people in the chart. Phew!! But there is more. After you create your chart 
and you right click on it, there are further options including deleting a person from 
the chart (or even from the file….. be careful of that one!!).

Once you have your chart as you want it, you can print it, save it and through 
the Share button export it as a PDF file (great for sending via email to someone), 
export it as an image for further work in your image editing software, or even 
upload it to Ancestry.com’s My Canvas, a paid chart printing service.

The above applies in most cases to all the charts in Family Tree Maker. The 
nice thing is that the controls are identical so once you get the hang of them you 
can apply them with confidence.

A descendant report
Note these vary slightly between FTM 2012/14 (Windows) and FTM for Mac2/3. 
Again select the focus person for the report.

With descendant reports the focus person is often the oldest person in a family 
line. Double clicking on the report in the Collection view will open the report. 
Again you have a number of options in the right hand editing panel. These 
include Items to Include like facts, those sources we discussed plus all those notes 
that you may have collected like stories etc.

A descendant chart
Then you can add headers and footer including page numbers and time and date 
of printing. Then you have page setup and saving too options which allow you 
to set up your page, size and margins etc, as well as saving your chart and its 
template for further use at a later time.

Basically it remembers how you set up your chart. Further down in the 
editing panel you can set the number of generations to include, (if you 
want the entire line put in a number like 99).

You can add backgrounds like a parchment effect and alter the 
numbering system to various recognized arrangements.

Again, you can Print or Share the report with a number of options 
including PDF, RFT and HTML and even an image.

Descendant chart
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A Family Group Sheet (FGS)
Again, a very common report. Start with the person that that you want to 
include in the FGS. This is usually the male head of a family. Double click 
on the FGS in the collection area and it opens. As you should now expect, 
the right-hand editing panel has options many of which you have seen 
before e.g. Items to Include, fonts and header, footer etc.

Family Group Sheet
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Now moving down you have some interesting options. If the person has 
multiple spouses you can select which spouse to highlight. If you have media 
entered in the silhouette boxes for the spouse and children, you can display them 
in the FGS along with a Family Picture if you have entered one in the Shared 
marriage Facts>Media in the Family>Person view. Also if you have a situation of 
multiple spouses with issue, turning on the Blended families option lets you see 
children from all spouses.

Again you have the usual output options.

Family view chart
This is one of the newer charts. It can be most useful in showing ancestors and 
family of the focus person.

Family view chart
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Output options
All charts and reports can be printed but also exported in various ways depending 
on the document through the Share button, which is next to the print button. The 
options vary, but essentially you have

PDF   Opens in Adobe Reader
One Page PDF  Opens in Adobe Reader
RTF   Opens in Word
CSV   Opens in Excel
HTML  Opens in a web browser
m   Opens in image editing applications 

The Send to option creates the report or chart in the nominated way then opens 
Outlook and attaches the report or chart. All you have to do is to add an email 
address and some notes as to whom you are sending it to.

Tip. Try sending a report or chart to yourself to see that you understand 
how it all works.

Reports
There are numerous reports in Family Tree Maker and space and the scope of 
this book Totally new does not allow me to go through all the reports and charts 
(this may be a subject for a follow-up book?) but I hope that I have given you an 
insight on how to go about it. The surname report is just one report which can be 
viewed in various guises and options—it lets you see all the names that you have 
in your file and you can sort them by surname count.

Additionally, both 2014 and Mac 3 have added extensive new chart capability. 
These include:

List of Individuals report
The previous Index of Individuals report (from the Person reports group) has been 
enhanced to include the following options. Each of the options below can now be 
filtered to display only living individuals if that option is selected.

Birthday list—it’s back!!! 
This displays the name, birthdate, and coming birthday for each person listed. 
If deceased people are included, the list also displays the death date and age at 
death. This was a favourite of mine in Family Tree Maker 16 and earlier and it 
was a great report to have at a family reunion. 

Index of individuals by ID
Displays Person and Relationship ID facts that exist for individuals. 
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Anniversary list
Displays the marriage date, spouse, and coming anniversary for each person listed.

Index of individuals
This is the same report that was available before but now includes spouses. 

Contact list
Displays the name, address, email address, and phone number for each person listed. 

Birthdays of living individuals
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New list and individuals to include options

Extended family option in Reports
New ‘Extended family’ option is available in some reports (Individuals to include 
section). This new setting filters the report to include the following: 

All immediate family 
• primary individual 
• parents 
• siblings 
• spouses 
• children 

Plus extended family 
• grandparents 
• uncles/aunts 
• 1st cousins 
• nieces/nephews 
• grandchildren 
• spouses of all above 

This new extended family option joins the existing other options being:
• immediate family
• all individuals
• selected individuals which opens the select individuals filter

Report options



46

Chapter 9—Web Search workspace
In this area a number of things happen involving Family Tree Maker and the 
internet. Earlier in this book I mentioned the leaf hint facility in Family Tree 
Maker and how clicking on a leaf hint takes you to the Web Search workspace 
where you typically see a list of hints.

The centre part of the screen is effectively running a web browser, a cut down 
version of Internet Explorer in Family Tree Maker 2012/14, and a cut down 
version of Safari in Family Tree Maker for Mac. At the bottom of the centre part 
of the screen you see the person from your file that generated the leaf hint, and at 
the bottom right the data discovered online and a tantalising merge button.

Now if you have an Ancestry subscription you see the data but if you don’t you 
see a wonderful message along the lines of telling you how much you are missing 
and sign up today. Sound familiar? Actually a subscription to Ancestry.com can 
be a very cost effective way to research, but that is a topic for another day.

Web Search workspace
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Merging from Leaf hints
If you believe the new internet data are what you want press the merge button and 
the information will be presented in a Merge wizard where you can decide what 
to keep and what to reject. Pressing the usual OK then merges the data straight 
into your Family Tree Maker file. Your hand never leaves the mouse. Be aware 
though that a lot of Ancestry Member Trees that you can merge from may not 
contain accurate data. ‘Let the merger beware’!

Also, you can use your Ancestry.com subscription inside Family Tree Maker 
by clicking on new search as you would in any browser outside Family Tree 
Maker.

Using Web Search to search without and Ancestry subscription
But even if you do not have an Ancestry.com subscription you can still search 

and merge from the Web Search workspace.
Family Tree Maker allows you to create your own favourite sites, (you can 

copy and paste them from your browser), and use them in Family Tree Maker. 
One of my favourites is the LDS FamilySearch, another is ‘dear old Google’. The 
illustration below shows a Trove favourite being created.

On the left hand editing panel you click on New and add or paste your web 
site. Then clicking on it opens it in Family Tree Maker. 

Create new favourite web site

Ancestry merge wizard
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Web clipping
Do your normal searching. Now if the search returns something useful, turn on 
the web clipping tool which is a rather indistinct white button on the Search result 
detail tool line or maybe go to the Search menu and enable web clipping.

Now have a careful look at the three tabs at the bottom left hand part of the 
screen associated with the people in your Web Search workspace. They are Facts, 
Media and Notes.

If you, for example, have the media tab clicked and your search returned a 
media item you want to use, click on it and it will be surrounded by ‘Marching 
Ants’. The web clipping tool will now add it to the bottom right hand Search 
result detail box. Similarly for the Facts and the web clipping tool, if it sees a 
date or a place, will give you an option to save it as such. Notes are I think self-
explanatory. Turn the Notes tab on then select the Notes in the normal way.

If you are in the facts tab and select a date, Family Tree Maker web clipping 
tool then provides a way to clip it to the right Family Tree Maker field.

Now pressing the Merge will bring all your clipped data (Facts, Media and 
Notes) into the appropriate places in your file. Every time I demonstrate this at a 
workshop or user group, I get amazed gasps about how cool it is and why hasn’t 
the user been aware of it. 

It has in fact been in Family 
Tree Maker since version 2008, 
about six years ago but often 
overlooked. This one always 
causes a ‘why didn’t I know about 
this wonderful feature?’ comment 
at workshops.

Web clipping information

Clipping a birth fact
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Chapter 10—Final thoughts
I have used Family Tree Maker in its many guises for over 20 years and have 
often said it is the most addictive, intuitive and fun program that I have ever 
used. Over the years it has developed and matured and has taken advantage 
of confluence of the computer, the internet, online databases and related 
developments.

In this little Totally new book, I have tried to introduce you to a few of the 
program’s many features. My aim has been to get you started in a way that you 
are not overwhelmed.

Play with the program
As noted above, one of the suggestions that I often make to Family Tree Maker 
user groups and workshops that I run is to make a playfile file and practice new 
ideas with it before committing yourself to your main file—a bit like a golfer 
having a few practice swings. You can simply make up some names and dates or 
use a copy of a backup file, but being able to practice ‘in the sandbox’ is a great 
way to gain confidence.

Join a group
You will also benefit by joining a genealogy group that has expertise in Family 
Tree Maker. Victorian GUM Inc. is based in Melbourne, www.vicgum.asn.au. 
GUM was formed by enthusiasts in 1984 just to help folk use and enjoy their 
computers. You might consider joining fellow users in GUM. It has a very high 
Family Tree Maker membership and conducts numerous Family Tree Maker 
workshops, user groups and tutorials to assist Family Tree Maker users. 

There are also numerous other local Family History Groups scattered around 
Australia and New Zealand and a search online can quickly find them. Join one 
and I guarantee you will enjoy it and learn a lot faster.

In the Appendix of this book I have provided a list of what I consider to be 
good resources for users of Family Tree Maker and I encourage you to use them. 

But nothing beats a bit of practice and encouragement and support of fellow 
users. Family Tree Maker is the most popular genealogy software program in 
Australia and probably the western world and there is a lot of support out there.
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Appendix 1: Help resources
Web Links
Family Tree Maker 2012/14 Support: www.familytreemaker.com/Support/Index

FTM-Tech (Where all the high end users hang out, you need to subscribe to this one) 
http://lists.rootsweb.ancestry.com/index/surname/f/ftm-tech.html#FTM-TECH

Family Tree Maker Answers (Knowledge Base). Type in a few key words and mostly you will be 
linked to an article on the topic http://ftm.custhelp.com/app/answers/list

Ancestry/Family Tree Maker Knowledge Base (similar to Family Tree Maker Answers above)  
http://ancestry.custhelp.com/app/home

Family Tree Maker software (Win) http://boards.ancestry.com/topics.software.famtreemaker/mb.ashx 

Family Tree Maker software (Mac) http://boards.ancestry.com/topics.software.ftmmac/mb.ashx

Family Tree Maker Blog (is languishing a bit)  
http://blogs.ancestry.com/ancestry/category/products/ftm

Ancestry.com Blog (active and very interesting) http://blogs.ancestry.com/ancestry

Webinars (mouse down until you find the Family Tree Maker ones) www.ancestry.com/cs/us/videos

Family Tree Maker Tutorials (excellent for new users also in FTM for Windows program Help- not 
Mac) www.familytreemaker.com/Learn/Tutorials

A Private Family Tree Maker Blog spot. Russ Worthington is a power Family Tree Maker user and has 
a private blog spot with a lot of Family Tree Maker help http://ftmuser.blogspot.com.au

Ancestry.com/Family Tree Maker Phone Help, There is also an international toll free phone support for 
ANZ users—1-800-251-838 (toll free) in Australia or; 0800-442-100 (toll free) in New Zealand.

Books
Beyond the basics: a guide for advanced users of Family Tree Maker 2012 by T. Pedersen

The companion guide to Family Tree Maker 2012 by T. Pedersen

The companion guide to Family Tree Maker for Mac 2 by T. Pedersen

Available in Australia from various genealogy resellers Tana Pedersen is a staff writer with Ancestry.com.

John Donaldson
Updated March 2014
W. www.vicgum.asn.au
E. info@vicgum.asn.au
Victorian GUM®
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VicGUM® was founded in 1984 by a group of farsighted persons 
who could see advantages to genealogy recording by means of the 
new personal computers then becoming available.

VicGUM® exists to provide technical support and assistance to 
members. This technical assistance is provided by those members 
in the group who have the available expertise. Members have 
shown that they are willing to share their knowledge and expertise 
to benefit all members.

This technical expertise is not restricted to genealogy programs, 
but also includes related equipment such as computers, scanners 
and digital photography.

Members also receive the monthly Newsletter by e-mail. This 
contains a wide range of information including many articles 
about using the more popular genealogy computer programs and 
related technical issues.

Support is also provided by self-help User Groups. These 
groups have informal monthly meetings to provide assistance with 
the more popular genealogy programs. Each group is facilitated 
by a person experienced in the particular program. Details of 
meeting dates and locations are included on the website and in the 
Newsletter.

Another important method of assistance is the e-mail discussion 
group, GUMNET. This network is available to members only to 
obtain suggested solutions for technical problems. Using this 
resource the expertise of our membership is freely available to all. 

VicGUM® holds monthly meetings at which technical issues 
are presented to the members. In addition, there are a number of 
full day workshops covering software and technical equipment in 
detail.

More information can be found on our website at www.
vicgum.asn.au.  On this website is all the information needed 
about participating in the various meetings and workshops which 
are held by the Association. It is also possible to download a 
membership application form.

John Donaldson, the author of this publication is also the 
Secretary of VicGUM®.

Doug Elms
President of Victorian GUM Inc president@vicgum.asn.au
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• Migration to New Zealand: a guide for family history researchers
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• Tracing your Scottish ancestors
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• ScotlandsPeople: the place to launch your Scottish research
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• Social media for family historians (2nd edition)

Coral Shearer
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About the author

John Donaldson

John Donaldson started using Family Tree Maker (FTM) when it was 
released as a two floppy disk program for Windows 3.1 in 1994. 
Since then he has used all the versions, and now uses both FTM 
2014 for Windows and FTM for Mac 3

In 1996 he applied to beta test the program, when Brøderbund 
Software in San Francisco was producing it. Whilst the program 
has gone through a number of owners and is currently owned by 

Ancestry.com, John has continued to be involved in beta testing, and has participated 
in some 16 consecutive releases.

In March 1998 he commenced writing a series of FTM columns for the Victorian GUM 
Inc. (www.vicgum.asn.au) newsletter and this series has continued unabated and 
now consists of some 160 plus tutorial articles. John is also the Hon. Secretary of 
Victorian GUM Inc.

In 2005, coinciding with the ownership of FTM by Ancestry.com, John and three others 
were invited to become alpha testers to advise the developers on future ideas for 
the program and act as a conduit of experienced users to the development team. 
As part of that involvement (the alpha group is now the ‘alpha 8’), John has visited 
Provo, Utah twice. John relates being able to spend the day with the developers as 
something akin to being in genealogical heaven. 

As well as writing about FTM, John runs regular FTM user groups and workshops for 
Victorian GUM and regional groups, as well as actively participating in a number of 
FTM message boards around the world.

John’s comment about FTM is that it is the most addictive, intuitive and FUN program 
that he has ever used. 
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 Unlock the Past is about promoting 
history, genealogy and heritage in 
Australia and New Zealand. It is a 
collaborative venture involving a 
team of expert speakers, writers, 
organisations and commercial 
partners throughout Australia, 
New Zealand and overseas.

What is Unlock the Past?
•  A major events resource -  

supporting existing events and 
running major events of our own

• A publisher of important guide books
•   A major go-to place for products,  

services and other resources
•  A significant free content site
•  A cost effective marketing  

platform for societies, libraries  
and commercial partners

•  A user of, and educator in, social media
•  Promoting heritage tourism  

… and much more
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Family Tree Maker, usually called FTM, is Australia’s 
largest selling genealogy program. It has enjoyed 
huge success and is now in its 22nd iteration 
as FTM 2014. In December 2013 Ancestry.com 
announced Family Tree Maker Mac 3 which was 
released in Australia in March 2014.

The program has developed extensively and since 
purchased by Ancestry.com in 2004 it has become 
even more tightly integrated with the  
Ancestry.com database. It has also become very 
internet aware with its use of Bing Maps and 
the ability to link to internet sites like Trove 
from within the program as well using a very 
convenient web clipping and merging capability.

The program is sold throughout Australia and 
New Zealand in retail packs that include access to 
Ancestry.com paid databases.

This book is intended to be the first of a series 
about Family Tree Maker, and covers the absolute 
basics that new users, with very little computer 
understanding can use to get up and running.

The book takes new users through installation, 
registration, activating an Ancestry.com 
subscription, followed by an introduction to 
creating or importing files. It then introduces the 
eight workspaces within the program with enough 
simple explanation to start using it.

Extensive use is made of screen shots to assist the 
user to understand what he or she is seeing on the 
screen. 
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